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Abstract

Brakes and tires are the major contributors for catastrophic failure of ground vehicles. Braking

system is the utmost important besides tire to ensure the safety of users and vehicle.
Ensuring good condition of brake lining is very crucial to ensure the efficiency of the braking

system, where, the worn off brake lining not only endangers life but also damages the entire
brake associated parts such as hub, disk, shaft, etc. It consists of a sensor. One sensor is
connected with the brake shoe. The signal from the sensor is given to a micro-controller.
When the brake shoe is worn out, the sensor senses signal to the micro-controller. The
micro-controller analyses the signal and operates the corresponding indicator. Brake pad
worn out detection sensor is mounted in the brake pad and it is connected to the Node MCU.
Therefore, a critical investigation of the existing pads manufactured and their
characterizations are conducted to identify the most suitable sensor spot on the brake pad.
Later, a micro sensor is embedded into the pad and fully tested on a specially designed test rig.
The evaluation of thickness, hardness, layer properties and critical wear region has enabled
the spotting of exact sensor location. The embedment of the micro switch was successfully
done and tested to be very efficient in alerting the driver upon reaching the maximum lining
wear limit. Finally, when the brake pad is fully wasted then the system provides a signal the

brake pad is in risk by the Blynk app.
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CHAPTER 1
INTRODUCTION

1.1 Introduction

In this paper, a review of previous research project that are related to this project will be
discussed. These kind of surveys were held as one of the tools to have some ideas on how this
project works. It is based on other achievement and also to formulate the advantage of
proposed solution. This may help in problem solving skills and options required for design and
develop of wear sensors. The brake pad wear sensor accurately informs the driver about the
current condition of the vehicle's brake pad. Sensor is mounted on the brake pad, one sensor
for the front axle and one sensor for the rear can be installed to determine and indicate when
the driver needs to perform a replaced. Brakes are the most important safety system in our
vehicles. Brakes give us the ability to slow down or stop the vehicle in an instant and can help

us to avoid a serious accident.

If the Brakes aren’t well maintained or regularly inspected then it can let you down when you
need them the most. This brake pad wear sensor has longer life and no need to visually inspect
the brake pad. 1.1 What are the most common brake system issues? The most common brake
system problem include: a spongy brake pedal , a hardest brake pedal , squealing sound when
braking, vibrations when braking and a persist brake warning light . A healthy brake system
should not make noises or vibrate, and should be firm when pressed, rather than soft or hard. If
you hear or feel something unusual when braking, it’s important to contact your local car
mechanic as soon as possible. To avoid expensive repair bills you should schedule regular

services that include full brake and brake pad inspections.

1.2 Issues occurs due to brake pad wear One of the main issues is safety as brakes plays an
very important role in our vehicle to immediately stop at every situations hence our braking
system should be as well as proper condition When the brake pad wear out as driver doesn’t
know the brake pad status that can causes the brake disc damage where the cost of the disc is
more than 80% as about brake pads. 1.3 What should my brake inspection include? All brake
inspection should be include a test drive, so your car mechanic can test the effectiveness of
your brakes firsthand. They should also conduct a visual inspection to The brake pad wear

sensor accurately informs the driver about the current condition of the vehicle's brake pad.
1



Sensor is mounted on the brake pad, one sensor for the front axle and one sensor for the rear
can be installed to determine and indicate when the driver needs to perform a replaced. Brakes
are the most important safety system in our vehicles. Brakes give us the ability to slow down
or stop the vehicle in an instant and can help us to avoid a serious accident. If the Brakes
aren’t well maintained or regularly inspected then it can let you down when you need them the
most. This brake pad wear sensor has longer life and no need to visually inspect the brake pad.
1.1 What are the most common brake system issues? The most common brake system problem
include: a spongy brake pedal , a hardest brake pedal , squealing sound when braking,
vibrations when braking and a persist brake warning light. A healthy brake system should not
make noises or vibrate, and should be firm when pressed, rather than soft or hard. If you hear
or feel something unusual when braking, it’s important to contact your local car mechanic as

soon as possible.

To avoid expensive repair bills you should schedule regular services that include full brake
and brake pad inspections .measure your brake pad and shoe thickness to ensure they are
wearing evenly and meet all required safety standards. A car mechanic will also check your
rotors for hotspots, your calipers for wear, and your wheel cylinders, brake lines and master
cylinder for leaks. They will also check the levels and quality of your brake fluids and ensure
that your brake and anti-lock brake sensors are properly placed and routed. Whether you are
experience issues with your braking or you simply want to schedule an inspection. Brake pad
sensor is used to indicate the status of your brake pad current condition. It is an essential
element of the braking system. It is used for monitoring life of brake and brake pad. It is

highly resistance to the high temperature.

1.2 Background

Though the world is getting modernized, we have to face so many problems. One of such
problems is accidents. One of the things that everyone tried to avoid is while traveling is
accidents, and sometimes it is inevitable. Now- a-days we can see accidents in every nook
and corner of the world. It results in the death of thousands of lives. In foreign countries they
take remedial measures for the prevention of accidents. When the driver brakes they are
actually pushing a plunger into the master cylinder, which in turn pushes brake fluid through

tubes and hoses to brake all the moving units in the vehicle. So many other devices are there
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to predict brake failure like United States patent 3711827, United States patent 3914734, etc.
The United States patent 3711827 is a self-test incorporated to determine if the warning light
is operated properly. But my project can indicate brake pad condition by notification. Driver

can aware from this notification and assure human safety from accident.

1.3 Study on Different Pad Materials

Ceramic Brake Pads They are the most expensive types of brake pads are available but they
are last longer than any other type. The ceramic compound brake pads are made of is great for
absorbing the heat that results from any type of continuous and hard, violent braking. In fact
even in endurance racing these ceramic brake pad can stand up to what you put them through,
and they work efficiently whether your brakes or warm or cold. These are made with small
amounts of copper and clay, which is molded into the compound to make for a strong and

long-lasting brake pads

Motorcycle braking systems have varied throughout time, as motorcycles evolved from
bicycles with an engine attached, to the 220 mph (350 km/h) prototype motorcycles seen
racing in MotoGP. Most systems work by converting kinetic energy into thermal energy (heat)
by friction. On motorcycles, approximately 70% of the braking effort is performed by the front
brake. This however can vary for individual motorcycles; longer-wheelbase types having more
weight biased rearward, such as cruisers and tourers, can have a ‘greater effort applied by the
rear brake. In contrast, sports bikes with a shorter wheelbase and more vertical fork geometry
can tolerate higher front braking loads. For these reasons, motorcycles tend to have a vastly

more powerful front brake compared to the rear.

Low metallic brake pad these brake pads are made, they tend to be quite noisy and lot of
brake dust. However they have excellent heat transfer capabilities and are made with up to
30% metal such as copper or steel. They are organic in nature and offered excellent braking
capabilities. Low metallic brake pads are greatest when it comes to braking and heat transfer,

and the materials that they are made of are completely organic.

Non-Metallic Brake Pads Non-metallic brake pads are the softest type of pads, being made
of various rubbers, resins, and glasses, along with a small number of metal fiber. The

composite material will wear away quickly and should only be used for regular, daily road-
3
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driving. Because they are soft , non-metallic brake pad are not the top choice for people who
drive a lot or put their vehicles through a lot each and every day , but for driver who do not put
a lot of mileage on their vehicle every year, these pads are fine. If you do more driving, you
should either purchase the metal-type brake pads or be prepared to change your non-metallic
ones frequently. Regular organic pads cause a lot of dust to cover components located near the
brakes, along with other materials that are thought to be toxic to human life, which is one of
the many reasons that the non-metallic brake pads were developed. If your vehicle does not
have large brake need these types of brake pads will suffice. If you choose alternatives the
price may be a bit higher but they will last you much longer than regular non-metallic brake

pads.

Non-Asbestos Organic (NAO) Brake Pads These types of brake pads are made of materials
such as high-temperature resins, fibers, and fillers. They are softer than the semi-metallic type
of brake pad and they create more dust in the long run. The brake pads also deteriorate rather
quickly, so it behooves the car-owner to pay attention to their pros and cons before purchasing
a set of these brake pads. ~ Semi metallic brake pad In the majority of vehicles semi-metallic
brake pads are mostly used. Made with a combination of metal and synthetic components, they
are a mostly metallic hybrid compound. An organic resin seal all of the materials together, and
they are molded into various shapes and baked in a furnace to hardened them. Semi-metallic
brake pads are very durable, as well as heat-resistance and resistance to wear. However
because these pads have a lower friction coefficient when it comes to lower temperature, they

need a little more pedal power when the brake are cold.

Semi-metallic brake pads are usually made sintered graphite, iron, or steel, and therefore
they are great when you need the high-performance capability in yours vehicle. In fact, these
types of brake pads are perfect for heavy vehicles and performance of vehicles because they
are study, well-made, and diverse brake pads. They contain up to 65% metal, but they also are
noisier to operate , wearing down your rotor a lot faster than other types of brake pads, and

don’t always perform well at low temperatures.



1.4 Objective:
The objectives of this project are:
a) To study about Automobile Brake Pads Performance and Longevity Monitoring

System.

b) Monitor their brake pads, detect signs of wear and tear, and take the necessary action to

replace worn-out brake pads.

c) To test the performance of the Automobile Brake Pads Performance and Longevity

Monitoring System.



CHAPTER 2
LITERATURE REVIEW

2.1 Literature Review

The literature review is carried out to understand the important of brake pad and the present
development in the brake pad monitoring system. Lots of researches work is carried out in
order to understand the various characteristics of brake pads materials as well as the types
of brake pads. Many authors try to focus their research on effect of various speed limits and
normal contact pressure on brake pads. Some research also carried out to development of
economical brake lining wear indicating system. The recent investigation by N.Chand S. A.
R. Hashimi S. Lomash and A. Naik was toward development of asbestos free brake pads.
This experiment focuses on physical of new material asbestos free with wearing properties.
From their experiment, it is says that the asbestos-free friction lining material can be used

for brake as well as other friction lining applications [1].

Mikael Erikson , Filip Bergman , Staffan Jacobson have investigated the surface
characterization of brake pad after running under silent and squealing condition . This
experiment focus on the previously almost unexplored area of the connection between brake
pad surface topography and the occurrence of squeals. From the experimental result , they
indicated that pads with small contact plateaus have a larger tendency to generate squeal
than pads with a few large plateaus. More over in the silent pressure interval, the size of the
contact plateaus increases rapidly with brake pressure [2] Friction layer and friction film on
PMC brake pad were investigated by W. Osterle, I. Urban , using Focused Ion Beam
technique, where, it was used to characterize superficial layers at micro-contact areas of a

commercial brake pad.

The friction material was a polymer matrix composite (PMC) with approximately 50%
metal content (semi metallic) and the counter part was a cast iron rotor. Experiment
depending on the constituent of the pad , one , two or three layers were identified. The
experiment is show that the FIB technique provides additional information which in
combination with the more conventional technique (L M) , (S E M)and (T E M) increases
the knowledge on the role of third body formation and superficial layers on brake pads. [3]

Zmago Stadiler Kristoffer Krnel Tomaz Kosmac have researched friction behavior of
6



sintered metallic brake pads on a C/CSiC composite brake disc. This experiment was aimed
studying on the frictional and wear property of sintered metallic (MMC) brake lining in
combination with a C/C— SiC brake disc. From the result, they conclude that the friction
performance of MMC-type brake pads on a C/C-SiC brake disc is dependent on the base
metallic matrix composition and formation of a friction layer on the brake pads surface [4].
The effect of metal fiber of the friction performance of automotive brake friction materials
were. The literature review is carried out to understand the important of brake pad and the
present development in the brake pad monitoring system. Lots of research’s work is carried
out in order to understand the various characteristics of brake pads materials as well as the

types of brake pads.

Many authors try to focus their research on effect of various speed limits and normal
contact pressure on brake pads. Some research also carried out to development of
economical brake lining wear indicating system. The recent investigation by N.Chand S. A.
R. Hashimi S. Lomash and A. Naik was toward development of asbestos free brake pads.
This experiment focuses on physical of new material asbestos free with wearing properties.
From their experiment, it is says that the asbestos-free friction lining material can be used
for brake as well as other friction lining applications [1]. Mikael Erikson, Filip Bergman ,
Staffan Jacobson have investigated the surface characterization of brake pad after running
under silent and squealing condition . This experiment focus on the previously almost
unexplored area of the connection between brake pad surface topography and the
occurrence of squeals. From the experimental result, they indicated that pads with small
contact plateaus have a larger tendency to generate squeal than pads with a few large

plateaus.

More over in the silent pressure interval, the size of the contact plateaus increases rapidly
with brake pressure [2]. Friction layer and friction film on PMC brake pad were
investigated by W. Osterle, I. Urban , using Focused lon Beam technique, where, it was
used to characterize superficial layers at micro-contact areas of a commercial brake pad.
The friction material was a polymer matrix composite (PMC) with approximately 50%
metal content (semi metallic) and the counter part was a cast iron rotor. Experiment
depending on the constituent of the pad , one , two or three layers were identified. The
experiment is show that the FIB technique provides additional information which in
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combination with the more conventional technique (L M) , (S E M)and (T E M) increases
the knowledge on the role of third body formation and superficial layers on brake pads. [3]
Zmago Stadiler Kristoffer Krnel Tomaz Kosmac have researched friction behavior of
sintered metallic brake pads on a C/CSiC composite brake disc. This experiment was aimed
studying on the frictional and wear property of sintered metallic (MMC) brake lining in
combination with a C/C— SiC brake disc. From the result, they conclude that the friction
performance of MMC-type brake pads on a C/C-SiC brake disc is dependent on the base
metallic matrix composition and formation of a friction layer on the brake pads surface [4].
The effect of metal fiber of the friction performance of automotive brake friction materials

were investigated by H. Jang K . Ko S.J. Kim R.H. Basch and J.W. Fash [5].

This experiment investigate the effect of different metallic fiber upon friction and wear
performance of various brake friction couple . The results show that, when gray cast iron
was used as a counter disk at low temperatures, the friction materials containing copper or
steel fibers showed high speed sensitivity M.Boniardi F. D’Errico C. Tagliabue G. Gotti and
G. Perriconne [6] have investigated failure analysis of a motorcycle brake disc. The failure
has studied on small cracks on the disc brake. These crack were mainly located near by the

holes placed on flange to ventilate and refresh pad .

From the result, it is stated that the lifespan of a motorcycle brake disc depend strictly on
the geometry (position of holes, shape of spokes, etc.)the material properties at high
temperatures and operating conditions Werner Osterle and Ingrid Urban [7] investigated
about third body formation on brakes and rotors. The experiment was focused on the
surfaces of a brake pads and rotors after a run-in period during which a stable coefficient of
friction had been developed. The Focused Ion Beam technique (FIB) is used to reveal
tribologically induced surface films and for cross-sectional preparation of superficial layers.
It was found that the definitely exists a third body at the surfaces of both counterparts and it
comprises of a Nano crystalline microstructure which implies that investigations on the

nanometer scale are essential for understanding the frictional behaviors of such contacts.



2.2 Brake Pad

Brake pads are a component of disc brakes used in automotive and other applications.
Brake pads are composed of steel backing plates with friction material bound to the surface

that faces the disc brake rotors.

Function

Brake pads convert the kinetic energy of the vehicle to thermal energy through friction.
Two brake pads are contained in the brake with their friction surfaces facing the
rotor.['! When the brakes are hydraulically applied, the caliper clamps or squeezes the two
pads together onto the spinning rotor to slow and stop the vehicle. When a brake pad heats
up due to contact with the rotor, it transfers small amounts of its friction material onto the
disc, leaving a dull grey coating on it. The brake pad and disc (both now having the friction

material), then "stick" to each other, providing the friction that stops the vehicle.

In disc brakes, there are usually two brake pads per disc rotor. These are held in place and
actuated by a caliper affixed to the wheel hub or suspension upright. Racing calipers,
however, can utilize up to six pads, with varying frictional properties in a staggered pattern
for optimum performance. Depending on the properties of the material, the weight of the
vehicle and the speeds it is driven at, disc wear rates may vary. The brake pads must usually
be replaced regularly (depending on pad material) to prevent brake fade. Most brake pads
are equipped with a method of alerting the driver when this needs to be done. A common
technique is manufacturing a small central groove whose eventual disappearance by wear
indicates the end of a pad's service life. Other methods include placing a thin strip of soft
metal in a groove, such that when exposed (due to wear) the brakes squeal audibly. A soft
metal wear tab can also be embedded in the pad material that closes an electric circuit when

the brake pad wears thin, lighting a dashboard warning light.

History

The concept of brake pads or disc brakes as an alternative to drum brakes had been around
at least as early as a patent by F. W. Lanchester in 1902. However, due to high cost and
inefficiencies compared to drum brakes they were not commonly implemented until

after World War II. Once disc brake technology improved, brake performance quickly
9
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surpassed that of drum brakes. The performance difference was most noticeably exhibited
in 1953 when a Jaguar outfitted with brake pads won the 24 Hours of Le Mans Grand Prix
of Endurance race. The success of the Jaguar is commonly attributed to the car’s disc brakes,
which allowed the drivers to approach turns faster and brake later than their opponents,
which ultimately led to its victory. As late as 1963 the majority of automobiles using disc
brakes were European made, with American cars adopting the technology in the late 1960s

after the invention of fixed calipers that made installation cheaper and more compact.

2.3 Materials

The most important characteristics that are considered when selecting a brake pad material

are as follows:

o The material's ability to resist brake fade, caused by an increase in temperature
the material will experience from the conversion of kinetic energy into thermal
energy.

e The effects of moisture on brake fade. All brakes are designed to withstand at
least temporary exposure to water.

e The ability to recover quickly from increased temperature or moisture, and
exhibit approximately the same friction levels at any point in the drying or
cooling process.

e The friction coefficient of modern brake pads should be low enough prevent
locking of the wheels but high enough to provide sufficient stopping power.
Friction coefficients are typically between 0.3 and 0.5 for brake pad materials.

o The ability to resist wear due to friction, but not to the extent that rotor wear
occurs more quickly than brake material is sacrificed.

e The ability of the material to provide smooth and even contact with the rotor or
drum, instead of a material that brakes off in chunks or causes pits, dents, or
other damage to the surface in contact.

o The ability to apply appropriate frictional force while also operating quietly.

10
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Another material requirement that is considered is how compressible the brake pads are; if

they are too compressible then brake travel can be excessive. Brake pad material must also

be porous so that water does not affect the friction coefficient.

Asbestos was added as a common ingredient to brake pads post-WWI, as car speeds began

to increase, because research showed that its properties allowed it to absorb the heat (which

can reach 500 °F) while still providing the friction necessary to stop a vehicle. However, as

the serious health-related hazards of asbestos eventually started to become apparent, other

materials had to be found. Asbestos brake pads have largely been replaced by non-asbestos

organic (NAO) materials in first world countries. Today, brake pad materials are classified

into one of four principal categories, as follows:

Non-metallic materials - these are made from a combination of various synthetic
substances bonded into a  composite, principally in the form
of cellulose, aramid, PAN, and sintered glass. They are gentle on rotors, but produce
a fair amount of dust, thus having a short service life.

Semi-metallic materials - synthetics mixed with varying proportions of flaked
metals. These are harder than non-metallic pads, more fade-resistant and longer
lasting, but at the cost of increased wear to the rotor/drum which then must be
replaced sooner. They also require more actuating force than non-metallic pads in
order to generate braking torque.

Fully metallic materials - these pads are used only in racing vehicles, and are
composed of sintered steel without any synthetic additives. They are very long-
lasting, but require more force to slow a vehicle while wearing off the rotors faster.
They also tend to be very loud.

Ceramic materials - Composed of clay and porcelain bonded to copper flakes and
filaments, these are a good compromise between the durability of the metal pads,
grip and fade resistance of the synthetic variety. Their principal drawback, however,
is that unlike the previous three types, despite the presence of the copper (which has
a high thermal conductivity), ceramic pads generally do not dissipate heat well,
which can eventually cause the pads or other components of the braking system to
warp. However, because the ceramic materials cause the braking sound to be

elevated beyond that of human hearing, they seem exceptionally quiet.

11
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2.4 Block Diagram:

Battery
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Figure 2.1: Block Diagram of Automobile Brake Pads Performance and Longevity

Monitoring System.

2.5 Circuit Diagram
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Figure 2.2: Schematic Diagram of Automobile Brake Pads Performance and Longevity

Monitoring System.
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2.6 Components List:

Hardware Part:

Software Part:

A

Node MCU
Battery

Buck Converter
Ultrasonic Sensor

LCD Display

Arduino IDE
Easy EDA
Remote XY
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CHAPTER 3
HARDWARE AND SOFTWARE ANALYSIS

3.1 Node MCU

Node MCU is an open-source firmware for which open-source prototyping board designs are
available. The name "Node MCU" combines "node" and "MCU" (micro-controller unit). The
term "Node MCU" strictly speaking refers to the firmware rather than the associated

development kits.

Both the firmware and prototyping board designs are open source. The firmware uses the Lua
scripting language. The firmware is based on the eLua project, and built on the Espressif Non-
OS SDK for ESP8266. It uses many open source projects, such as lua-cjson and SPIFFS. Due
to resource constraints, users need to select the modules relevant for their project and build a
firmware tailored to their needs. Support for the 32-bit ESP32 has also been implemented.

ESP8266 NODE MCU

ESP8266-12E 3.3V Voltage Regulator IC

Flash Button

F Micro USB

2.4GHz Connector

Antenna
Reset Button

USB to TTL
Converter IC

Figure 3.1: Node MCU

The prototyping hardware typically used is a circuit board functioning as a dual in-line
package (DIP) which integrates a USB controller with a smaller surface-mounted
board containing the MCU and antenna. The choice of the DIP format allows for easy
prototyping on breadboards. The design was initially was based on the ESP-12 module
of the ESP8266, which is a Wi-Fi SoC integrated with a Tensilica Xtensa LX106 core,

widely used in [oT applications.
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Figure 3.2: Node MCU Schematic Diagram

This an open source IoT platform. It includes firmware which runs on the ESP8266 Wi-
Fi SoC from Express if Systems, and hardware which is based on the ESP-12 module. The
term "Node MCU" by default refers to the firmware rather than the development kits. The
firmware uses the Luascripting language. It is based on the eLua project, and built on the
Espress if Non-OS SDK for ESP8266. Node MCU was created shortly after
the ESP8266 came out. On December 30, 2013, Espressif Systems [} began production of
the ESP8266. The ESP8266 is a Wi-Fi SoC integrated with a Tensilica Xtensa LX106 core,
widely used in IoT applications (see related projects). Node MCU started on 13 Oct 2014,
when Hong committed the first file of node mcu-firmware to GitHub.[''l Two months later,
the project expanded to include an open-hardware platform when developer Huang R
committed the gerber file of an ESP8266 board, named devkit v0.9.['?] Later that month,
Tuan PM ported MQTT client library from Contiki to the ESP8266 SoC platform,!'3! and
committed to NodeMCU project, then Node MCU was able to support the MQTT IoT
protocol, using Lua to access the MQTT broker. Another important update was made on 30
Jan 2015, when Devsaurus ported the u8glibto Node MCU project,!'>! enabling Node MCU
to easily drive LCD, Screen, OLED, even VGA displays. In summer 2015 the creators

abandoned the firmware project and a group of independent contributors took over.
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Figure 3.3: Node MCU Pin Out

Node MCU V3 ESP8266 ESP-12E is Wi-Fi development board that helps you to prototype
your IoT product with few Lua script lines, or through Arduino IDE. The board is based on
ESP8266 ESP-12E variant, unlike other ESP-12E, you won’t need to buy a separate
brakeout board, USB to serial adapter, or even solder it to a PCB to get started, you will
only need a USB cable (Micro USB).

Features

Communication interface voltage: 3.3V.

Antenna type: Built-in PCB antenna is available.
Wireless 802.11 b/g/n standard

WiFi at 2.4GHz, support WPA / WPA2 security mode
Support STA/AP/STA + AP three operating modes

AR o e

Built-in TCP/IP protocol stack to support multiple TCP Client connections (5

MAX)

7. DO ~ D8, SD1 ~ SD3: used as GPIO, PWM, IIC, etc., port driver capability
I15mA

8. ADO: 1 channel ADC

9. Power input: 4.5V ~ 9V (10VMAX), USB-powered
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10. Current: continuous transmission: =70mA (200mA MAX), Standby: <200uA
11. Transfer rate: 110-460800bps

12. Support UART / GPIO data communication interface

13. Remote firmware upgrade (OTA)

14. Flash size: 4MByte.

3.2 5V Regulator IC

Voltage sources in a circuit may have fluctuations resulting in not providing fixed
voltage outputs. A voltage regulator IC maintains the output voltage at a constant
value. 7805 IC, a member of 78xx series of fixed linear voltage regulators used to
maintain such fluctuations, is a popular voltage regulator integrated circuit (IC). The
xx in 78xx indicates the output voltage it provides. 7805 IC provides +5 volts

regulated power supply with provisions to add a heat sink.

7805 IC Rating:

e Input voltage range 7V- 35V
e Current rating Ic = 1A

e Output voltage range V. Max=5.2V ,V. Min=4.8V

LM-7805 IC 5V, 1.5A voltage regulator

7805 Pinout

Figure 3.4: 5V Regulator IC
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3.3 Battery

Lithium batteries are primary batteries that have metallic lithium as an anode. These types
of batteries are also referred to as lithium-metal batteries. They stand apart from other
batteries in their high charge density and high cost per unit. Depending on the design and
chemical compounds used, lithium cells can produce voltages from 1.5 V (comparable to

a zinc—carbon or alkaline battery) to about 3.7 V.

Disposable primary lithium batteries must be distinguished from secondary lithium-ion or
a lithium-polymer,!!! which are rechargeable batteries. Lithium is especially useful, because
its ions can be arranged to move between the anode and the cathode, using
an intercalated lithium compound as the cathode material but without using lithium metal as
the anode material. Pure lithium will instantly react with water, or even moisture in the air;

the lithium in lithium ion batteries is in a less reactive compound.

Lithium batteries are widely used in portable consumer electronic devices. The term
"lithitum battery" refers to a family of different lithium-metal chemistries, comprising many
types of cathodes and electrolytes but all with metallic lithium as the anode. The battery
requires from 0.15 to 0.3 kg of lithium per kWh. As designed these primary systems use a
charged cathode, that being an electro-active material with crystallographic vacancies that

are filled gradually during discharge.

Figure 3.5: 3.7V Battery
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Product Specification

Voltage 3.7V
Product Type Lithium-Ion
Battery Capacity 2200mAh
Weight 45 ¢
Model Number ICR 18650

3.4 Ultrasonic Sensor

An ultrasonic sensor is an electronic device that measures the distance of a target object by
emitting ultrasonic sound waves, and converts the reflected sound into an electrical signal.
Ultrasonic waves travel faster than the speed of audible sound (i.e. the sound that humans
can hear). Ultrasonic sensors have two main components: the transmitter (which emits the
sound using piezoelectric crystals) and the receiver (which encounters the sound after it

has travelled to and from the target).

HC-SR04 Ultrasonic Sensor - Working

As shown above the HC-SR04 Ultrasonic (US) sensor is a 4 pin module, whose pin names
are Vcc, Trigger, Echo and Ground respectively. This sensor is a very popular sensor used
in many applications where measuring distance or sensing objects are required. The module
has two eyes like projects in the front which forms the Ultrasonic transmitter and Receiver.

The sensor works with the simple high school formula that
Distance = Speed x Time
The Ultrasonic transmitter transmits an ultrasonic wave, this wave travels in air and when it

gets objected by any material it gets reflected back toward the sensor this reflected wave is

observed by the Ultrasonic receiver module as shown in the picture below-

19



Figure 3.6: Ultrasonic Sensor

Now, to calculate the distance using the above formulae, we should know the Speed and
time. Since we are using the Ultrasonic wave we know the universal speed of US wave at
room conditions which is 330m/s. The circuitry inbuilt on the module will calculate the
time taken for the US wave to come back and turns on the echo pin high for that same
particular amount of time, this way we can also know the time taken. Now simply calculate

the distance using a micro-controller or microprocessor.

How to use the HC-SR04 Ultrasonic Sensor

HC-SR04 distance sensor is commonly used with both micro-controller and
microprocessor platforms like Arduino, ARM, PIC, Raspberry Pie etc. The following guide
is universally since it has to be followed irrespective of the type of computational device
used.Power the Sensor using a regulated +5V through the Vcc ad Ground pins of the sensor.
The current consumed by the sensor is less than 15mA and hence can be directly powered
by the on board 5V pins (If available). The Trigger and the Echo pins are both I/O pins and
hence they can be connected to I/O pins of the micro-controller. To start the measurement,
the trigger pin has to be made high for 10uS and then turned off. This action will trigger an
ultrasonic wave at frequency of 40Hz from the transmitter and the receiver will wait for the
wave to return. Once the wave is returned after it getting reflected by any object the Echo
pin goes high for a particular amount of time which will be equal to the time taken for the
wave to return back to the sensor.The amount of time during which the Echo pin stays high

is measured by the MCU/MPU as it gives the information about the time taken for the wave
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to return back to the Sensor. Using this information, the distance is measured as explained

in the above heading.

Applications

e Used to avoid and detect obstacles with robots like biped robot, obstacle avoider
robot, path finding robot etc.

e Used to measure the distance within a wide range of 2cm to 400cm

e Can be used to map the objects surrounding the sensor by rotating it

e Depth of certain places like wells, pits etc can be measured since the waves can

penetrate through water

Ultrasonic Sensor Pin Configuration

Pin
Pin Name Description
Number

1 Vce The Vcc pin powers the sensor, typically with +5V

‘ Trigger pin is an Input pin. This pin has to be kept high
2 Trigger e .

for 10us to initialize measurement by sending US wave.

Echo pin is an Output pin. This pin goes high for a
3 Echo period of time which will be equal to the time taken for

the US wave to return back to the sensor.
4 Ground This pin is connected to the Ground of the system.

HC-SR04 Sensor Features

e Operating voltage: +5V

e Theoretical Measuring Distance: 2cm to 450cm
e Practical Measuring Distance: 2cm to 80cm

e Accuracy: 3mm

e Measuring angle covered: <15°

e Operating Current: <I5SmA

e Operating Frequency: 40Hz
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3.5 LCD Display
LCD (Liquid Crystal Display) screen is an electronics display module and find a wide

range of applications. A 16x2 LCD display is very basic module and is very commonly
used in various devices and circuits. These modules are preferred over seven segments and
other multi segment LEDs. The reasons being LCDs are economical; easily programmable,
have no limitation of displaying special & even custom characters (unlike in seven
segments), animations and so on. A 16x2 LCD means it can display 16 characters per line
and there are 2 such lines. In this LCD each character is displayed in 5x7 pixel matrix.
This LCD has two registers, namely, Command and Data. The command register stores
the command instructions given to the LCD. A command is an instruction given to LCD
to do a predefined task like initializing it, clearing its screen, setting the cursor position,

controlling display etc.

Features of LCD Display:

5 x 8 dots with cursor

Built-in controller (KS 0066 or Equivalent) + 5V power supply (Also available for + 3V)
1/16 duty cycle B/L to be driven by pin 1, pin 2 or pin 15, pin 16 or A.K (LED) N.V.
optional for + 3V power supply.

Figure 3.7: 16*2 LCD Display

3.6 Arduino IDE

The digital micro-controller unit named as Arduino Nano can be programmed with the
Arduino software IDE. There is no any requirement for installing other software rather than

Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to the
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micro-controller on our board). The IC used named as ATmega328 on the Arduino Nano
comes pre burned with a boot loader that allows us to upload new code to it without the use

of an external hardware programmer.

Communication is using the original STK500 protocol (reference, C header files). We can
also bypass the boot loader and programs the micro-controller through the ICSP (In Circuit
Serial Programming) header. The ATmegal6U2 (or 8U2 in the revl and rev2 boards)
firmware source code is available. The ATmegal6U2/8U2 is loaded with a DFU boot loader,

which can be activated by:

On Revl boards: connecting the solder jumper on the back of the board (near the map of
Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling the
8U2/16U2 HWB line to ground, making it easier to put into DFU mode.

The Arduino Nano is one of the latest digital micro-controller units and has a number of
facilities for communicating with a computer, another Arduino, or other micro-controllers.
The ATmega328 provides UART TTL at (5V) with serial communication, which is
available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the data.
An ATmegal6U2 on the board channels this serial communication over USB and appears
as a virtual com port to software on the computer. The '16U2 firmware uses the standard
USB COM drivers, and no external driver is needed. However, on Windows, an .in file is
required. The Arduino software includes a serial monitor which allows simple textual data

to be sent to and from the Arduino board.

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-
to-serial chip and USB connection to the computer (but not for serial Communication on
pins 0 and 1). A Software Serial library allows for serial communication on any of the
Nano's digital pins. The ATmega328 also supports [2C (TWI) and SPI communication. The
Arduino software includes a Wire library to simplify use of the 12C bus. Arduino programs
are written in C or C++ and the program code written for Arduino is called sketch. The
Arduino IDE uses the GNU tool chain and AVR Lab to compile programs, and for
uploading the programs it uses argued. As the Arduino platform uses Atmel micro-
controllers, Atmel's development environment, AVR Studio or the newer Atmel Studio,

may also be used to develop software for the Arduino.
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Figure 3.8: Arduino Software Interface IDE

The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a
text editor for writing code, a message area, a text console, a toolbar with buttons for
common functions and a series of menus. It connects to the Arduino and Genuino hardware

to upload programs an communicate with them.

Writing Sketches

Programs written using Arduino Software (IDE) are called sketches. These sketches are
written in the text editor and are saved with the file extension .ino. The editor has features
for cutting/pasting and for searching/replacing text. The message area gives feedback while
saving and exporting and also displays errors. The console displays text output by the
Arduino Software (IDE), including complete error messages and other information. The
bottom right hand corner of the window displays the configured board and serial port. The
toolbar buttons allow you to verify and upload programs, create, open, and save sketches,

and open the serial monitor.
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NB: Versions of the Arduino Software (IDE) prior to 1.0 saved sketches with the
extension .pde. It is possible to open these files with version 1.0, you will be prompted to

save the sketch with the .ino extension on save.

Sketchbook

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store
your programs (or sketches). The sketches in your sketchbook can be opened from the
File > Sketchbook menu or from the Open button on the toolbar. The first time you run the
Arduino software, it will automatically create a directory for your sketchbook. You can

view or change the location of the sketchbook location from with the Preferences dialog.

Beginning with version 1.0, files are saved with a .ino file extension. Previous versions use
the .pde extension. You may still open .pde named files in version 1.0 and later, the

software will automatically rename the extension to .ino.

Tabs, Multiple Files, andompilation

Allows you to manage sketches with more than one file (each of which appears in its own
tab). These can be normal Arduino code files (no visible extension), C files (.c extension),

C++ files (.cpp), or header files (.h).
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Uploading Before uploading your sketch, you need to select the correct items from the
Tools > Board and Tools > Port menus. The boards are described below. On the Mac, the
serial port is probably something like /dev/tty.usbmodem241 (for a Uno or Mega2560 or
Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or
/dev/tty. USATI9QWI1DbIP1.1 (for a serial board connected with a Keyspan USB-to-Serial
adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COMS,
COM7, or higher (for a USB board) - to find out, you look for USB serial device in the
ports section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx ,
/dev/ttyUSBx or similar. Once you've selected the correct serial port and board, press the
upload button in the toolbar or select the Upload item from the Sketch menu. Current
Arduino boards will reset automatically and begin the upload. With older boards (pre-
Diecimila) that lack auto-reset, you'll need to press the reset button on the board just before
starting the upload. On most boards, you'll see the RX and TX LEDs blink as the sketch is
uploaded. The Arduino Software (IDE) will display a message when the upload is complete,

or show an error.

When you upload a sketch, you're using the Arduino Boot loader, a small program that has
been loaded on to the micro-controller on your board. It allows you to upload code without
using any additional hardware. The Boot loader is active for a few seconds when the board
resets; then it starts whichever sketch was most recently uploaded to the micro-controller.
The Boot loader will blink the on-board (pin 13) LED when it starts (i.e. when the board

resets).

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or
manipulating data. To use a library in a sketch, select it from the Sketch > Import Library
menu. This will insert one or more #include statements at the top of the sketch and compile
the library with your sketch. Because libraries are uploaded to the board with your sketch,
they increase the amount of space it takes up. If a sketch no longer needs a library, simply

delete its #include statements from the top of your code.
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There is a list of libraries in the reference. Some libraries are included with the Arduino
software. Others can be downloaded from a variety of sources or through the Library
Manager. Starting with version 1.0.5 of the IDE, you do can import a library from a zip file

and use it in an open sketch. See these instructions for installing a third-party library.
Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of your sketchbook
directory. Platforms installed there may include board definitions (which appear in the
board menu), core libraries, Boot loaders, and programmer definitions. To install, create the
hardware directory, then unzip the third-party platform into its own sub-directory. (Don't
use "Arduino" as the sub-directory name or you'll override the built-in Arduino platform.)

To uninstall, simply delete its directory.

For details on creating packages for third-party hardware, see the Arduino IDE 1.5 3rd party

Hardware specification.
Serial Monitor

This displays serial sent from the Arduino or Genuino board over USB or serial connector.
To send data to the board, enter text and click on the "send" button or press enter. Choose
the baud rate from the drop-down menu that matches the rate passed to Serial begin in your
sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your sketch)

when you connect with the serial monitor.

3.7 EasyEDA Software

EasyEDA is a web-based EDA tool suite that enables hardware engineers to design,
simulate, share - publicly and privately - and discuss schematics, simulations and printed
circuit boards. Other features include the creation of a bill of materials, Gerber files and
pick and place files and documentary outputs in PDF, PNG and SVG formats.EasyEDA
allows the creation and editing of schematic diagrams, SPICE simulation of mixed analogue
and digital circuits and the creation and editing of printed circuit board layouts and,

optionally, the manufacture of printed circuit boards.
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Subscription-free membership is offered for public plus a limited number of private projects.
The number of private projects can be increased by contributing high quality public projects,
schematic symbols, and PCB footprints and/or by paying a monthly subscription.
Registered users can download Gerber files from the tool free of charge; but for a fee,
EasyEDA offers a PCB fabrication service. This service is also able to accept Gerber file

inputs from third party tools.

Start r U *New Project

e

Figure 3.9: EasyEDA Software Interface

3.8 Remote XY:
Remote XY is easy way to make and use a mobile graphical user interface for controller

boards to control via smartphone or tablet. The system includes:

o Editor of mobile graphical interfaces for controller boards, located on the site

remotexy.com
e Mobile app Remote XY that allows to connect to the controller and control it

via graphical interface. Download app.
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Distinctive features:

o The interface structure is stored in the controller. When connected, there is no
interaction with servers to download the interface. The interface structure is
downloaded to the mobile application from the controller.

e One mobile application can manage all your devices. The number of devices is

not limited.
Supported connection methods:

e Internet over Cloud Server;

e Wi-Fi client and access point;

¢ Bluetooth;

o Ethernet by IP or URL;

e USB OTG (Android only that support USB OTG);

Supported boards:

e Arduino UNO, MEGA, Leonardo, Pro Mini, Nano, MICRO and compatible
AVR boards;

o ESP8266 boards;

o ESP32 boards;

e Chip KIT UNO32, Chip KIT uC32, Chip KIT Max32;

Supported communication modules:

e Bluetooth HC-05, HC-06 or compatible;
e Bluetooth BLE HM-10 or compatible;

e ESP8266 as modem:;

e FEthernet W5100;

Supported IDE:

e Arduino IDE;
29



o FLProg IDE;

« MPIDE;
Supported mobile OS:

e Android;

e 10S;

Remote XY is easy way to make a unique graphical interface to control micro-controller

device via mobile application, Arduino for example.

Remote XY allows:

e To develop any graphical management interface, using the control, display and
decoration elements any combination thereof. You can develop the graphical
interface for any task, placing the elements on the screen using the online editor.
Online editor posted on the website remotexy.com.

o After the development of the graphical interface, you get the source code for the
micro-controller that implements your interface. The source code provides a
structure for interaction between your program with the controls and display. Thus
you can easily integrate the control system into your task for which you are
developing the device.

e To manage micro-controller device using your smartphone or tablet with the
graphical interface. For manage used mobile application Remote XY.

o Using one mobile application, you can manage a large number of devices with
different graphical management interfaces. As the interface description is stored on

board the micro-controller device.

the source code for the micro-controller, for example a sketch for the Arduino, you
opened it in the IDE. In the simplest case, you can download the sketch in Arduino
board and test your interface immediately, connecting via a smartphone. But often you
need to integrate the developed graphical interface with your problem you want to

solve it using the Arduino. Next, we will show how it is easy to do.
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The generated source code have a part that is starts with tag Remote XY include library
and ends with tag END Remote XY include. This part of the code defines the structure of
the graphical interface that you have created. In turn, this structure is also divided into parts.

Consider the order.

Select connection mode and include library

The code contains a definition of how you use the connection of interface. This definition of
the form REMOTEXY MODE  XXX. For example, if you use Software Serial, this
definition would be REMOTEXY MODE SOFTWARESERIAL, if you use Hardware
Serial - REMOTEXY MODE SERIAL respectively.

Additionally this section of code contains the necessary includes libraries to provide the
necessary functionality. Also connects library Remote XY.h. There is no need to change

this part of code.

Connection settings

This part of the code in more detail defines the characteristics of the selected connection.
For example, if you are using a connection via Software Serial, you can determine which
pins micro-controller will be connected to the Bluetooth module. You can also determine
the rate of exchange with the Bluetooth module, if it is different from the default 9600 baud.
All definitions are set by default, but you can change them as you need. This is the only

section of code in the included section of Remote XY that you can change.

ESP8266 Wi-Fi module

ESP8266 module allows to use RemoteXY with micro-controller device for Wi-Fi.
Implemented support for all Arduino boards. The source code of GUI can be download for

the Arduino IDE and PLProg.

To use the ESP8266 module to select this module in the properties configuration settings.
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Figure 3.10: Configure Remote XY

Remote XY allows to configure module for operate in one of two modes: access point and

client. Client allows to connect the module to an existing Wi-Fi access point.

Access point mode of ESP8266 configures the module as an access point and allows to
connect Arduino directly to this point. The access point is available to connect to it from
smartphone or tablet within a radius of availability of the radio signal. It does not require
any other network infrastructure. This connection mode can be used in the far away place
where there is no computer networks and the Internet. To configure this mode in the

configuration properties of editor need to select the type of connection "Wi-Fi access point."

Client mode of ESP8266 configures the module for automatically connect to an existing Wi-
Fi access point, such as a home router or enterprise access point. At the same time
connected to the Arduino module ESP8266 must be located in the physical availability of
the radio signal of access point. Connecting to the device from smartphone or tablet will be
not directly, but through the Ethernet network, an IP address provided by the DHCP server
to ESP8266 module. It allows to connect to the Arduino device from anywhere in the local
network as well as from the Internet. Connect from the Internet is possible with the correct

configuration of the router, such as the use of the virtual server. To configure this mode in
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the configuration properties of editor need to select the connection type "Ethernet" and

select ESP8266 module.

The module is connected to the micro-controller board via serial interface. You can choose
to use software serial or hardware serial. Module connection option is selected in the

module interface settings of editor. The module is controlled via AT commands.

Connection via Software Serial

It allows to connect the module to an arbitrary micro-controller pins. The pins used must be
select in the module interface settings of editor. Also in the settings must be select the baud
rate for serial port. ESP8266 default configured to 115200 baud. To work through Software
Serial, must configure the transmission speed ESP8266 to a lower speed. Stable operation
of the module is possible at a speed of no more than 19200 baud. To change the speed of
module serial interface, must to connect it to the console to the possibility of the AT
commands. Module serial interface speed can be changed with the AT command

"AT+UART_ DEF=19200,8,1,0,0".

Connection interface:

Software Serial ¥
RX pin: TX pin:

2 v 3 : 4
Speed (baud rate):

9600 v

Wi-Fi access point:
Mame (SSID):
Remotexy
Open point
Password (8 or more chars):
12345678
Port:

6377

Figure 3.11: Module Interface
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There are some limitations on the use of the RX pin for Arduino boards. Limitations

associated with do not support to pins interrupt of the micro-controller.

e On Arduino RX doesn't work on pin 13;

e On Mega and Mega2560 only the following can be used for RX: 10, 11, 12, 13, 14,
15, 50, 51, 52, 53, A8(62), A9(63), A10(64), A11(65), A12(66), A13(67), A14(68),
A15(69);

e On Leonardo and Micro only the following can be used for RX: 8, 9, 10, 11, 14, 15,
16;

Also, when using Software Serial you should take the following limitations:

e No ability to work at high baud rates. It is not recommended to use a baud rate of
more than 19200.
e Some libraries, which also uses interrupt may not work correctly. For example Servo

library, the servos will twitch.

Connection via Hardware Serial

It allows to connect the module to the micro-controller pins, supporting one of the hardware
serial ports. For different Arduino boards are different ports and contacts. Hardware serial
allows to work module at a maximum connection speed of 115200 baud. The baud rate for
Arduino is selected in the module interface settings of editor. ESP8266 must be to pre-
configured to work at the same speed as the Arduino. The baud rate setting of modules can

be made via AT commands. Next Arduino serial ports are available:

e Arduino UNO and Nano: Serial (RX-0, TX-1);
e Arduino MEGA and MEGA2560: Serial (RX-0, TX-1), Seriall (RX-19 u TX-18),
Serial2 (RX-17 u TX-16), Serial3 (RX-15 u TX-14);

>Which port to use, and therefore the pins should be connected to the module, you must
select in interface settings of editor. It should also be borne in mind that for Arduino boards
Serial port enabled for the micro-controller programming, and if you decide to use this port,
you must disconnect the ESP8266 module when programming it. A good solution is to use
the boards Arduino MEGA any port other than Serial.
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« Module interface

Connection interface:

| Hardware Serial v |
Serial port:

| Serial, pins O(RX) u 1(TX) v |
Speed (baud rate):

| 9600 v

Wi-Fi access point:
Mame (SSID):
|Remula)(‘:‘ |

[ Open point

Password (8 or more chars):
112345678 |

Port:

6377

Figure 3.12: Module Interface
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CHAPTER 4
Methodology

4.1 Our methodologies for the project:

* Creating an idea for the design and construction of Automobile Brake Pads
Performance and Longevity Monitoring System. And designing a block diagram to

know which components we need to construct it.
* Collecting all the components for our desired system.

* Setting up all the components in a system. Then assembling all the blocks in a

system and finally running the system to check if it actually works or not.

4.2 Working Principle

The working principle of motorcycle brake pads is based on the frictional force between
the brake pads and the rotor or drum. The brake lever or pedal, the brake caliper
compresses the brake pads against the rotor or drum, creating friction that slows down or
stops the motorcycle. Here we use a Node MCU micro-controller which is the main
controller unit for this system. This micro-controller is mainly powered from the battery.
Ultrasonic sensor is mounted in the brake pad and it is connected to the Node MCU. Here
we divide the brake pad condition in four parts in Remote XY. When the condition of
brake pad wasting rate will 25% then Buzzer will be Sound on in Remote XY. In this same
process when brake pad wasting rate will 55%,75% then the condition will detect by the
Ultrasonic sensor and send it by Node MCU through IoT. Here also use like Node MCU,
Ultrasonic Sensor, Buck Converter, battery, LCD Display. Here all data shows in LCD

Display. This is the main procedure of this system.
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4.3 Final Project View

Figure 4.1: Final Project Overview
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CHAPTER 5
RESULT AND DISCUSSION

5.1 Result

Now, it’s time to talk about the results. We have written our commands using the Arduino
IDE and the following things can happen: Our project is Automobile Brake Pads
Performance and Longevity Monitoring System. In our project making we used PVC
boards for total hardware making. After finally completing this project, we run it & we
observed the output of this project. We can see that it is working well as expected. We took

some photos and mobile screen shots as reference.

® [n this project first we setup a power source system. In real life we will connect our
project with vehicle battery.

® After that we will establish a circuit where we use a micro-controller and a sensor.

® Sensor will measure the brake pad condition and Show the LCD Display.

® All Data Show in LCD Display.
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Experiment 1:

Brake Pad Position 1

D)

break pad ok

Results on system display

Results on mobile screen

Experiment 2:

Brake Pad Position 2

=

break pad ok

Results on system display

Results on mobile screen
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Experiment 3:

Brake Pad Position 3

change break pad

Results on system display

Results on mobile screen

Experiment 4:

Brake Pad Position 4

| Break Pad: 2@5:' ,l

>

I
—
change break pad

Results on system display

Results on mobile screen
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5.3 Advantage

Improved safety.

Extended lifespan of brake pads.

Cost savings.
Improved performance.
Peace of mind.

Simple construction

Ease of operation

5.4 Application

It can be used for various type of vehicle Likes:

Motorcycle
Car

Auto Rickshaw
Motor Van
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5.1 Discussion

Maintaining the brake system of a motorcycle is crucial for rider safety, and monitoring the
brake pads is an essential aspect of brake system maintenance. Worn-out brake pads can
lead to longer stopping distances, reduced braking performance, and even brake failure,
which can cause accidents. Therefore, it is vital for motorcycle riders to know how to
monitor their brake pads and take the necessary action to replace them when necessary.
Regular inspection is crucial for monitoring brake pads. The frequency of inspection will
depend on how frequently the motorcycle is used, but it is recommended to inspect the
brake pads every 3,000 miles or every six months. During inspection, the rider should look
for visual signs of wear, such as uneven wear patterns, cracks, or a shiny appearance. When
replacing worn-out brake pads, it is essential to use high-quality pads from reputable
manufacturers. Inferior quality brake pads may wear out faster and not provide adequate
stopping power, which can compromise rider safety. Proper maintenance of the brake
system can help prolong the life of the brake pads and ensure optimal braking performance.
Keeping the brake system clean and free from dirt and debris and using the recommended

brake fluid can help prevent premature wear of the brake pads.
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CHAPTER 6
CONCLUSION

6.1 Conclusion:

Monitoring the performance of a brake pads system makes it possible to conduct real-time
assessment of its various components and to decide on whether the design is adequate to
achieve the desired performance outcomes. The work presented in this paper features
research effort undertaken to design, construct, and brake pads monitoring system. The
various measurable parameters relevant to brake performance have been system. We are
proud to express our delight as the project we embarked upon is successfully finished within
the target date. The project gave us more confidence that we will be able to put in practice,
whatever theoretical knowledge. we gained during our course of study till now. If really
persuades us to do more and more, perhaps in better way in our future. Brake failure
indicator is a early warning system. it constantly monitors the condition of the brake and

give audio visual indication.

6.2 Future Scope

The model can be improved by making some changes some components. Some suggestions

are given below.

® We will improve advanced Brake Monitoring System.

® We will add an engine shut down feature. The vehicle will remain shut down until the

brake pads are changed.
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Appendix

#include <LiquidCrystal 12C.h>

LiquidCrystal 12C lcd(0x3F, 16, 2); // 12C address 0x3F, 16 column and 2 rows 270r3F

#define trigPin D5

#define echoPin D6

long duration;

long distance;

int math=130;

int pad,

#define REMOTEXY MODE ESP8266WIFI LIB CLOUD
#include <ESP8266WiFi.h>

#include <RemoteXY .h>

/I RemoteXY connection settings

#define REMOTEXY_ WIFI_SSID "abcde"

#define REMOTEXY WIFI PASSWORD "123456789"

#define REMOTEXY CLOUD SERVER "cloud.remotexy.com"

#define REMOTEXY CLOUD PORT 6376

#define REMOTEXY CLOUD_ TOKEN "aade5a4b062201cf193f9f8bac453e79"

/I RemoteXY configurate

#pragma pack(push, 1)

uint8 t RemoteXY CONF[]= // 34 bytes
{255,0,0,34,0,27,0,16,31,1,66,0,22,35,18,39,133,31,69,0,
24,9,17,17,1,67,4,2,85,60,7,36,31,31 };

// this structure defines all the variables and events of your control interface

struct {
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// output variables

int8 tlevel 1;//=0..100 level position

intl6_t sound 1; // =0 no sound, else ID of sound, =1001 for example, look sound list in

app
char text 1[31]; // string UTF8 end zero

// other variable

uint8 t connect flag; // =1 if wire connected, else =0

} RemoteXY;
#pragma pack(pop)

void setup()

{
RemoteXY Init ();

Serial.begin(115200);

led.clear();
led.init();  // initialize the lcd
lcd.backlight(); // open the backlight
pinMode(trigPin,OUTPUT);
pinMode(echoPin,INPUT);

// TODO you setup code

void loop()

{
RemoteXY Handler ();

// TODO you loop code
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// use the RemoteXY structure for data transfer
// do not call delay()
RemoteXY.level 1= pad;

digital Write(trigPin, LOW));
delayMicroseconds(2);
digital Write(trigPin, HIGH);
delayMicroseconds(10);
digital Write(trigPin, LOW));
duration = pulseln(echoPin, HIGH);
distance= (duration*0.034/2)*17;

pad=math-distance;

Serial.print("distance ");

Serial.println(distance);

lcd.setCursor(0, 0); // start to print at the first row

lcd.print("Brake Pad: ");
led.print(pad );
led.print("%");
delay(200);
if (pad<70) {
RemoteXY.sound 1=2001;
strcpy (RemoteXY.text 1, "change brake pad");
}
if (pad>70) {
RemoteXY.sound 1=0;
strcpy (RemoteXY.text 1, "brake pad ok");

j
j
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